
Mendeley Institutional Edition

What is Mendeley Institutional Edition (MIE)?

● It is a reference management tool that lets researchers store, read, annotate, and cite literature both individually and

collaboratively. It is also an academic social network that helps researchers to collaborate with others online and

discover the latest research.

● This edition has more features than the free version of Mendeley.

1. GET STARTED

Activities:

1.1 Create a free account

1.2 Complete your profile

1.3 Download and install Mendeley web importer

1.4 Join DLSMHSI Mendeley group

1.1 Create a free account

To be able to explore Mendeley, you should create first a free account by following the steps below:

o Go to www.mendeley.com and click Sign in via your institution.

▪ For faculty and students: Use your Microsoft Office 365. Enter De La Salle Medical and Health

Sciences Institute. Then choose Microsoft Azure sign in option. Enter your Microsoft Office 365

email and password.

http://www.mendeley.com


1.2 Complete your profile

Your profile on Mendeley is how you communicate who you are and what you’ve done as a researcher on the Mendeley

network. Rather than a typical social networking profile, your Mendeley profile focuses on your scholarship.

The more information you share on your profile, the better your Mendeley experience will be. For example, adding your

research interests (see below) will allow Mendeley Suggest to provide more specific recommendations for papers that you

should read as well as allowing potential collaborators to get a sense of what you’re about.

To edit your profile, follow these steps:

a. Click your name at the upper right to access your profile.

b. Complete your profile by filling out the details.

c. Make sure to update your profile when necessary.

1.3 Download and install Mendeley Web Importer

Mendeley Web Importer is a browser extension that imports papers, web pages and other documents directly into your

reference library from search engines and academic databases. It is available for Chrome, Firefox, and Microsoft Edge. Safari

is not supported.

For the documentation on supported browsers, please go to

https://service.elsevier.com/app/answers/detail/a_id/18117/kw/word%20processors/supporthub/mendeley/

Steps in downloading and installing Mendeley Web Importer:

a. Open the browser where you wish Mendeley Web Importer to be installed.

b. Go to https://www.mendeley.com/reference-management/web-importer/

c. Click Get Web Importer then click Add extension.

1.4 Join DLSMHSI Mendeley group

It is important to be a part of DLSMHSI Mendeley group since it will enable you to be able to use the Mendeley Institutional

Edition, or the premium version. You may check the Institutional Groups tab under your profile name to see if you are a

member of the DLSMHSI Group. If you are not yet a member, please fill out the form here: http://bit.ly/mendeleygroup.

https://service.elsevier.com/app/answers/detail/a_id/18117/kw/word%20processors/supporthub/mendeley/track/APNlAAoqDv8Y~d5VGi8a~yKeL20qPi75Mv9i~zj~PP_r
https://www.mendeley.com/reference-management/web-importer/
http://bit.ly/mendeleygroup


2. SEARCH AND SAVE PAPERS

Activities:

2.1 Import full text articles

2.2 Import references from 3
rd
party site

2.3 Import references from iSearch

2.4 Import documents from computer

2.5 Add manual entry

2.6 Edit entries

2.1 Import full text articles

There are a number of online databases that our Library has subscriptions with. We can directly import our references from

these online databases. To do this, you may follow the steps below but please make sure that you have signed in to your

Mendeley account:

a. Go to www.sciencedirect.com (Please note that this is an example only. If you prefer other online databases, you may also

try them. If asked to log in via OpenAthens, please follow the instructions in the handout Using OpenAthens to access

resources remotely.)

b. Search for any topic using the search box

c. Once you have the search results, please click the title of an article which has a PDF full text available.

d. In the article view, click the Mendeley web importer.

e. Tick the box of the article you wish to save then click Add to Mendeley.

http://www.sciencedirect.com


f. Once you have added the article to Mendeley, go back to Mendeley and click Library. This will open the Mendeley

Library. Check if you have successfully saved the article.



2.2 Import references from 3
rd
party site

Aside from the Library’s subscribed online databases, we can also import references from third party websites, like Google

Scholar, to our Mendeley account. Please follow the steps below:

a. Go to https://pubmed.ncbi.nlm.nih.gov/ or www.scholar.google.com

b. Search for any topic using the search box

c. From the search results page, click the Mendeley Web Importer and choose the article/s you wish to save to your

Mendeley account.

https://pubmed.ncbi.nlm.nih.gov/
http://www.scholar.google.com


2.3 Import references from iSearch

iSearch, the discovery service of the Library, lets you search across all the resources available in the Library whether print or

online. Like what we did using other , we can also import references from iSearch to our Mendeley account. Please follow the

steps below:

a. Go to www.dlshsi.edu.ph

b. Click the Academics tab, then look for Romeo P. Ariniego, MD, AFSC Library

c. Once you are in the Library homepage, you can already see iSearch.

d. Using the search box, search for any topic you wish to look into.

e. From the search results page, click the title of the article you wish to save. (If asked to log in via OpenAthens, please

follow the instructions in the handout Using OpenAthens to access resources remotely)

http://www.dlshsi.edu.ph


f. Click Cite.

g. Click Export Citation and then select Export in RIS format. A file with “Delivery” filename will be downloaded.



h. Go back to your Mendeley Library. Click Add new then Import library then choose RIS. Select the RIS file that you have

downloaded then click Open.

2.4. Import documents from computer

In the event that you have a saved article or document in your computer that you either made yourself or got from other

people, you can also directly import them to your Mendeley account. Please follow the steps below to import document/s from

your computer:

a. Click Add new then choose Files from computer. You can import documents in Microsoft Word or PDF format.

b. Select the file that you wish to import, then click Open.

c. You can just also drag and drop the file from your computer to your Mendeley account.



2.5 Add manual entry

In case you wish to add print references that have no way of being uploaded online, you may opt to add a manual entry for

those references. Please follow the steps below to add a manual entry:

a. Click Add new then Add entry manually.

b. Select the type of entry, and then supply the necessary details such as title, author, year of publication, etc.

c. Click Save.





2.6 Edit entries

It is important to make sure that the saved references on your Mendeley account are correct and complete with important

details. Through editing the entries, we can ensure that the details are correct. To edit the entries, please follow the steps

below:

a. From your Mendeley Library, click any reference you wish to edit.

b. The details of the reference shall be shown at the right side. Click the information that you wish to review or edit.

c. Fill in the missing or incorrect details.

d. Click anywhere in the box to automatically save the edits you made.



Read: Supplement Handout on Finding bibliographic details in a source

This is a useful guide to help you look for the important information of a source when you check and edit your entries

in Mendeley.

3. MENDELEY REFERENCE MANAGER APPLICATION

Activities:

3.1 Download and install Mendeley Reference Manager application

3.2 Read papers, highlight and annotate

3.3 Create private groups and share PDF files

3.4 Mendeley Cite, insert citation, insert bibliography, and change citation style

3.5 Working offline with Mendeley Reference Manager

3.1 Download and install Mendeley Reference Manager application

a. Download the Reference Manager application in https://www.mendeley.com/download-reference-manager

b. Run the downloaded software.

c. Click install. Follow the other steps until you finish installing the software.

Mendeley Reference Manager is supported in Windows, Mac, and Linux.

For the documentation on supported operating systems, please go to

https://service.elsevier.com/app/answers/detail/a_id/18117/kw/word%20processors/supporthub/mendeley/

3.2 Read papers, highlight and annotate

https://www.mendeley.com/download-reference-manager
https://service.elsevier.com/app/answers/detail/a_id/18117/kw/word%20processors/supporthub/mendeley/track/APNlAAoqDv8Y~d5VGi8a~yKeL20qPi75Mv9i~zj~PP_r


Mendeley Reference Manager application has a built-in PDF viewer which allows multiple open documents, highlighting,

post-it-like note taking, and more. Please follow the steps below to read, highlight and annotate your references:

A. Open any saved reference with a small check icon next to its listing by either clicking the check icon, or double clicking the

reference listing.

B. Please note of the following useful tools in reading your references:

a. Text select tool – use this tool to select text within your document. You can use this to copy and paste relevant

passages, or to apply highlighting (see below).

b. Highlight tool – use this tool to apply highlighting to text within the document. The highlight tool will apply

whichever color is currently set as active (see below). Use the dropdown menu that appears next to the tool to switch

between text-based highlighting and rectangle-based highlighting. The latter can be useful for images, graphs,

charts, or large sections of text.

c. Note tool – use this tool to create notes at specific locations within the document – sometimes called ‘sticky notes’.

Click wherever you want the note to appear. The note tool will appear in whichever color is currently set as active.

d. Color selection – Mendeley supports highlighting in a number of different colors. Use this menu to select the

currently active color. Notes and highlighting that you apply will use this color. Note that you can change the color of

an existing note by using the dropdown menu that appears in the top right corner of the note when open. You can

change the color of an existing highlight by right clicking on it.

e. Fit – It has two options: fit to width, or fit to page.

f. Zoom – use these buttons to zoom into and out of the PDF.

g. Rotate – use this tool to rotate the PDF by 90 degrees.

h. Download – use this tool to download the PDF to your computer

i. Search – search within the PDF using this tool



3.3 Create private groups and share PDF files

In addition to organizing your personal research library and helping to write new papers, one of the key benefits of using

Mendeley is the opportunities it offers for collaboration and discovery. Mendeley’s Groups functionality is central to this.

Groups allow you to create and join teams of like-minded people. Whether you're joining colleagues working on a specific

project, a professor wanting to distribute a reading list to a class or looking to join a worldwide discussion on a particular

discipline, Mendeley Groups can help you achieve your goals.

● Create, curate and grow groups of people according to your needs.

● Control who can join and add materials to your group.

● Use private groups to collaborate directly on materials and share full papers.

● Join existing groups dedicated to sharing knowledge on a particular subject.

● Discover new research and potential collaborators in your field from around the world.

To create Groups, log in to your Mendeley Reference Manager account. Under Private Groups, click New group and type

the group name.



To make changes in the Group, right click the Group Name.

● Manage Group – allows you to invite group members

● Rename Group – allows you to edit the name of the Group

● Delete Group – allows you to remove the Group. This action can only be done by the Group Creator.

To invite a member to the group, click Manage Group then click Invite members. Enter the email address of the member you

wish to invite then click Send invites. You can view the group members under the Members tab and the members who have

been invited but have not accepted the invite in the Pending invites tab. You have an option to Resend the invite or Cancel

the invite.

Note: You may only send an invite to an email address with Mendeley account.



When you are invited to join group, you shall receive a notification in your email. If you wish to accept the invite, click Join this

group. You shall be prompted to sign in to your Mendeley Reference Manager.



When signed in to Mendeley Reference Manager, you shall see the pending invite. Click Accept to join the group or Decline if

otherwise.

3.4 Mendeley Cite, insert citation, insert bibliography, and change citation style

Mendeley Cite is a Word plugin that allows you to easily insert references from your Mendeley library into your Word

document, change your citation style and generate a bibliography - all without leaving your document. Mendeley Cite is

available in MS Word, Office 365, and Microsoft Word for iPad only.

For the documentation on supported text processors, please go to

https://service.elsevier.com/app/answers/detail/a_id/18117/kw/word%20processors/supporthub/mendeley/

https://service.elsevier.com/app/answers/detail/a_id/18117/kw/word%20processors/supporthub/mendeley/track/APNlAAoqDv8Y~d5VGi8a~yKeL20qPi75Mv9i~zj~PP_r


To install word plug in, follow the steps below:

Installing Mendeley Cite for Microsoft Word

a. Open your Reference Manager application and sign in.

b. Click the Tools tab and choose Install Mendeley Cite for Microsoft Word

c. This will open Mendeley Cite in Microsoft Apps Store. Click Get It Now.

d. Sign in using your Microsoft Office 365 account. Accept the Privacy Policy Agreement if prompted.



e. Launch Mendeley Cite by clicking Open in Word.

f. In MS Word, click the References tab. The Mendeley Cite icon appears at the right side of the toolbar.

g. Click the Mendeley Cite icon then sign in to your Mendeley Reference Manager account.



Inserting citations and references in MS Word using Mendeley Cite

a. Open MS Word. Click the References tab then click the Mendeley Cite icon. Log in to your account if prompted. To insert a

citation, click References, choose the source that you wish to cite, and click Insert 1 citation.



b. To insert a reference, click More then click Insert Bibliography.

c. To change the citation style, click Citation Style, choose the preferred citation format, then click Update citation style.

d. To look up a citation style other than those listed, click Citation Style then click Select another style. Look up your preferred

citation format in the search box.



Notes:

1. The accuracy of the bibliography list that you could insert using Mendeley depends on the bibliographic information

saved in your Mendeley Library. For example, if the record in the Mendeley Library has no page number, the

reference that you shall insert would also have no page number. Thus, it is important to check and edit your

Mendeley records (Section 2.6) so the citation and reference that you would create shall also be complete and

accurate.

2. Mendeley shall create the list of bibliography based on the citations that you have inserted within the document.

Thus, you need to insert citations first then insert the bibliography last so that all of the citations that you have

inserted would be included in the list of bibliography.

3.5 Working offline with Mendeley Reference Manager

a. To work offline, right click All References then choose Make Available Offline. This will download all your references then

you would be able to work with Mendeley Reference Manager even if there is no internet connection.




